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LIMac was estab lished in 1984, when
the Mac was introduced. Annual dues
for membership is
$36. First meeting is
free. For information,
contact any of the
following:
Membership
Donald Hennessy
(516) 541-3186
aboutlimac @ aol.com
Technical Advice
Bradley Dichter
(631) 348-4772
bdichter @ cdr.net
Program
Coordinator
Rick Matteson
rgmlimac
@ optonline.net
Photoshop SIG
Rich Scillia
(516) 783-6622
rscillia @ optonline.net
Photography SIG
Murray Hoffman
hoffmancamera
@ dav.net
Beginners SIG
Geoff Broadhurst
gahoof @ aol.com
Internet SIG
Al Choy
achoy @ optonline.net
Multimedia SIG
Bernie Flicker
twoflick
@ optonline.net

May’s Meeting
We were primed and ready to hear a talk
from Apple’s SOHO store in Manhattan, but
received a demonstration on the iLife suite by
Tafari Cousins from the Walt Whitman Mall
Apple Store, Apple’s newest retail location that
was opening the very next day!
Also dropping in at our LIMac meeting
were at least a half dozen of the Apple people
from the new store who invited us to drop by
and take a look. I saw them again the next day
on duty at the Walt Whitman Store and got a
big hello as did many of our members when
they also came by.
Thanks to Apple for a great evening. 0
–Donald Hennessy
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Pay Your 2003 Dues:
Send your $36 check to: Long Island
Macintosh Users Group, Post Office Box 2048,
Seaford, New York 11783-0180 or bring it to
the next meeting! 0

June’s Meeting
June’s general meeting
will feature Audible
Books, a means of listening to recorded books
on an MP3 player.
June’s general meeting
will feature Audible
Books, a means of listening to recorded books
on an MP3 player.
They answer the
question,“What is Audible?”on their Website:
“Audible digitally delivers a broad range of
audio programming over the Internet, anywhere, anytime. At audible.com, you can
choose from over 4 , 500 audiobooks and
14 ,000 other audio programs, download them
to your computer, and listen immediately.”
Audible uses an MP3 device or allows you
to burn them onto a CD.There are thousands
of audiobooks and audio editions of newspapers and magazines such as the WALL STREET
JOURNAL , THE NEW YORK TIMES , and
SCIENTIFIC AMERICAN. There is also a
selection of radio programs. 0
–Joan Bernhardt
Friday, June 13th at 7 p.m., Building 300,
(Anna Rubin Hall), New York Institute of
Technology, Old Westbury.
LIM
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The Internet SIG: Held at the Bethpage Public Library, (516) 931-3907,
on the third Monday of each month at 7:30 p.m.
Multimedia SIG: iMovie 3 new features and finishing the movie in
progress. Held on the third Monday of the month at 7:30 p.m. in Bernie
Flicker’s offices: ABC Industries, 100 Cleveland Avenue, Freeport, call
(516) 867- 8400, ext. 325 (send your e-mail address for details).
SIGs immediately before or after the general meeting:
Beginners SIG: 7 PM – Utilities, both Apple (Disk Utility, Print Center)
and third party (commercial and shareware – Snapz Pro, PopChar X).
MacSkills SIG: 7:45 PM – Extensis Suitcase.
DTP/Photoshop SIG: (TBD)
Photography SIG: 6:30; Bring your camera.
x LIMac meetings, unless otherwise noted, are held in Building
300 (Anna Rubin Hall) at the
New York Institute of Technology
on Northern Boulevard in Old
Westbury, L.I.
| In bad weather, call (516) 6867789.
| The next LIMac board meeting
will be at the Plainedge Library,
(516) 735-4133, on Wednesday,
June 18th, at 8 p.m.
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TidBITS Troubleshooting Primer, Part 1
by Adam C. Engst (ace @ tidbits.com)
(Continued from the May issue)
| On your computer, you need properly installed
file sharing client software.
| Your computer must have a working connection to the wireless access point.
| The access point must allow you to see a computer connected via wired Ethernet.
The wired Ethernet computer must have a
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TIPS!
Another way to
format text in Adobe
InDesign :
Most designers associate the Eyedropper
tool with its ability
to sample color from
images and objects.
However, this tool
can also sample text
attributes, providing
you a quick and easy
way to format text.
For example, let’s
say you have a text
block of formatted
text and you just
added several pages
of unformatted text
that you want to
format the same as
the prexisting text.
Simply select the text
you want to format
with the Type tool
(or click the Type
tool in the text and
press Command-A to
select the entire text
block) and then click
on the formatted
text block with the
Eyedropper tool. The
text that’s selected
will then become formatted with the character and paragraph
attributes applied
to the formatted
text you sampled.

working connection to the access point.
| File sharing server software must be running
on the wired Ethernet computer.
| A folder must explicitly be shared on the wired
Ethernet computer.
You could certainly break these pieces into
even smaller pieces, but this should be sufficient
to get started.
Keep in mind that what I’ve just described
is only one working system, which is important,

because if there are other working systems
– other wireless computers that can see the
file server – that can help you zoom in on the
problem quickly.
Note all of the pieces of the system briefly in
your notebook, and if you’re a picture person,
consider drawing yourself a diagram of how it all
fits together; this can come in especially handy
if you actually need to break the system apart by
disconnecting cables or rearranging equipment.

Ask Yourself Questions Now that you’ve
identified all the parts of the system, it’s time
to look carefully at each part, making up a possible reason why a failure at that point could
be responsible for the whole problem. In our
example, let’s take each part and analyze it,
asking questions that lead to tests.
File sharing client software is of course necessary, but since you were able to connect previously, it’s a good assumption that it’s installed.

President’s Message

Bradley’s Tech Session

MacWorld Creative Pro Expo will be at
the Javitz Center in New York City on July
16–18, 2003. If you would like to volunteer
half-day(s) at the LIMac booth, send me an
e-mail at ArchBill @ aol.com and place LIMacMacworld in the subject heading. Please
include your name, telephone number and
which half-day, you can participate: Wed. 10-2
or 2-6 ; Thurs. 10-2 or 2-6 ; Fri. 10-1 or 1-4.
You don’t have to be an expert. Just show
up with two things – a white shirt and black or
dark pants and shoes. The other requirement
is that you bring your smile with you. With
this outfit, all you have to do is tell passers-by
about our meetings and how we have a great
and informative time. Anecdotes and personal
experiences are always welcome.
Remember, this will be your last opportunity to be a participant, since the next year’s
Macworld will be in Boston. 0

| What external hard drive for my PowerBook do you recommend?
LaCie, SmartDisk or Other World Computing
brands. LaCie’s Data Bank stylish and tiny
20GB drive connects via USB or the 33 times
faster than FireWire and is powered by the
connection to the Mac. Next up is SmartDisk’s
FireLite drives in sizes from 20 to 60GB. Still
just derives it’s power from the Mac, but comes
with an AC adapter if you need it. In a clear
plastic case are the Other World Computing
Mercury On-The-Go little drives. They use
relatively high performance 2.5 inch drives at
up to 80GB. They have a nice Toshiba-based
60GB drive with a 16MB buffer and 5400 RPM
speed. Next comes the full size units, using
high performance 3.5 inch 7200 RPM drives.
LaCie’s d2 FireWire drives come in a durable
aluminum case and are very quiet. They start
at 80GB and get to 250GB before switching
to a double size case for the 400 and 500GB
drives. For the newest PowerBook G4 models,
Other World Computing has the Mercury
Elite Pro FireWire 800 and USB 2.0 drives also
up to 250GB. They use the latest Oxford 922
interface chip. The drive also accommodates
regular FireWire 400 and USB 1.1. You want to
avoid using USB -connected hard drives if possible, as they are extremely slow. Only the first
generation iBook and iMac desktop Macs had
USB but no FireWire.
| What is your experience with Verizon
DSL ? I’m told they are lowering their price.
Cablevision tells me they are raising the
price of Optimum Online next month.
They are lowering it by $5 a month for home
users and I think $10 a month for small businesses. They seem increasingly more competent in setting up the switch-over, but not
competent in helping Mac users, particularly
Mac OS X users, how to set things up. Not
that it’s in fact hard to do – they just don’t
seem to have any prepared notes. Regardless,
as I’ve set it up in Mac OS X in less than five
minutes, it’s been my experience that the DSL
users have a much slower connection than
cable modem users. Now I know individual
users will have slower or faster connections,
depending on their distance to the phone
company’s switching equipment, and cable
modem users’ speeds will be affected by the

PowerBook Tickets Going Fast!
Only a few tickets remain. Soon the winning
ticket will be drawn for our special raffle.
LIMac’s fi rst 233MHz Apple G3 PowerBook,
with shoulder bag and accessories. Only 100
total tickets will be sold at $5.00 each. You
could be that lucky winner. Come to the
June general meeting and buy another ticket:
improve your chances. 0
–Donald Hennessy
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Bradley Dichter
bdichter@cdr.net
The fill and stroke
color of the sampled
text will also be
applied, unless you
otherwise specify
in the Eyedropper
Options dialog box
for it not to be. To
access this dialog
box, double-click
on the Eyedropper
tool in the Toolbox.
Deselect any of the
option check boxes
for the attributes
you don’t wish the
the Eyedropper tool
to sample. Then,
click OK.
Ensuring the pages
in your Adobe
InDesign document are imposed
properly:
If you’re laying out an
InDesign document
that contains page
spreads and will be
sending the document as a PDF file
to a service bureau
for output, don’t
select the Reader’s
Spreads check box
in the Export PDF
dialog box. Selecting
this option will prevent the document
from being properly
imposed. Each page,
whether or not part
of a spread, should
be exported to PDF
as a separate page.
–Element K Journals

Is it turned on? Has anything changed since you
last connected successfully that might provide
a clue? Have you restarted (it’s always worth
trying)? What about other computers, both
wired and wireless? Can their file sharing client
software see the wired computer?
Is the wireless connection to the access
point working from your computer? Is it working
for other network-related tasks at the same
time you can’t connect to the wired computer?

‘‘’’
QUOTES

Advice to Software
creators from
Adam C. Engst :
(ace@tidbits .com)
“Finally, support Mac
OS X’s standard
folder organization.
Store preference
files in ~/Library/
Preferences (unless
your software
requires a systemwide license or preferences file, in which
case it should go in /
Library/Preferences).
Other support
files belong in
~/Library/Application
Support or /Library/
Application Support.
Don’t create new
directories in
~/Library or /Library
just for your application. Mac OS X’s
folder hierarchy may
seem confusing
at first, but that’s
only because it’s
so different from
Mac OS 9. The more
developers adhere
to this organizational
scheme, the easier
it is for users to
understand Mac OS
X – consistency is
the first step towards
comprehension. In
addition, it makes
product support
easier if all programs adhere to Mac
OS X’s organizational
design, users will
start to learn where
to look for particular
types of files.
“We all should be
aware of these rules
of location in Mac
OS X. ”

Can other wireless computers connect to the
access point?
Is the access point configured correctly
so wireless computers can see the wired
computer? Since it worked properly before,
this likely isn’t the source of the problem. Has
anything changed on the access point since you
last connected that could be related?
Can the wired computer connect to the
access point via its Ethernet cable? (Never

underestimate the trouble a broken or flaky
cable can cause.)
Is file sharing turned on and configured properly? Has anything changed on that computer
that might have resulted in it being turned off
or reconfigured? Have you restarted the wired
computer recently?
Is the shared folder still shared? Could
someone have changed which folders were
shared? Has the folder been moved or renamed

or otherwise modified in some way that might
have changed its state?
I mentioned the difference between reproducible and intermittent problems above; if you
have an intermittent problem connecting to the
wired Ethernet computer, that generates additional questions. Does the problem happen
at all times of day? Does it happen right after
you’ve done something else? 0
(Continued in the July FORUM )

More of Bradley’s Tech Session
number of users in a development, but even
the slowest cable modem connection I’ve witnessed was a bit faster than the DSL users. For
Mac OS 9 users, Verizon DSL relies on a program called Mac POET for dialing the PPP over
Ethernet connection. If you use something like
Apple’s Software Update, it wants to quit all
other running programs during the download
and install procedure. This would sever your
Internet connection and thus the upgrades.
For this situation, I recommend interposing
a hardware cable/DSL router. It will do the
PPPoE for the DSL modem and offer the Mac
a DHCP connection which does not rely on a
application. One other thing for people to consider when thinking about moving from dialup to broadband: if your computer is a fairly
old model, less than a G3 model, then you may
not see an appreciable improvement in your
Web browsing and downloading experience
because the computer is just too slow to take
advantage of the faster net connection. Quite
a bit of the whole is the Web page rendering
speed of your computer.
| I want to get a webcam for videoconference/video phone Mac to PC .
Logitech doesn’t have anything for the
Mac. I found a possibility, ClearPhone. Any
comments?
ClearPhone Pro for Mac has not been updated
in three years and never was even updated to
work with Mac OS 9.1, let alone OS X . There
also used to be (for Mac OS 9 ) CU -SeeMe and
Freewebphone. Check out iSpQ VideoChat at
www.iSpQ.com/index.html. It works for Mac
OS 9, X and Windows ’98 to XP. Try it free for
30 days and only $40 fee. Mac OS X users can
try the free ohphoneX which works via H.323
protocol to work with Microsoft NetMeeting
or GnomeMeeting. Mac OS 9 users should give
iVisit a look, as it also works with a Windows
client. I’ve tried using the only commercial
product of the bunch, Smith Micro Software’s
VideoLink Pro. No Mac OS X support, though.
It does work with NetMeeting or any other
H.323 client. Rumor has it that a future version of Apple’s iChat will support video. As
for a Mac video source, check out the ADS
Technologies Pyro 1394 FireWire Webcam for
Mac OS 9. For Mac OS 9 and X , look at Orange
Micro’s i BOT and the i BOTpro which includes

a copy of iSpQ VideoChat and BTV Pro for
video captures. The same Web cam works with
Windows machines if they have a FireWire
port. See www.orangemicro.com/ibotpro.html.
Avoid the pathetic USB Web cams and the old
serial Web cams are long discontinued. The
iBOTpro sells for $99.99 at buy.com or $100.69
at amazon.com where you can get free Super
Saver Shipping. If you have a DV camcorder,
that makes for a much better quality source, as
the optics on these little Web cams are pretty
bad.
| I have Mac OS X (Jaguar) version 10.2.4 . I
see they are up to version 10.2.6 . Do I have
to upgrade to 10.2.5 first and then 10.2.6 ?
You can go directly to version 10.2.6 by either
making use of the Software Update System
Preference or downloading the Combo Updater.
See http://docs.info.apple.com/article.html?artn
um= 70174. The combo updaters are always preferred to the incremental updates as it makes
sure you have every updated fi le in place. Of
course, the download is rather large at around
80 megabytes.
| Is there a way to change the number of
recent items in the Apple menu?
Sure. Just use the General panel in System
Preferences. You have independent control of
the number of applications and documents.
You just select from the available choices in the
pop-up menus.
| Is it safe to keep the old version of a application after an upgrade? Should you uninstall the old version before installing the
new version?
Very often that’s not an option as the updater
replaces the old version with fi les of the same
name. You could Stuff a copy of the application folder and restore it if the updated
program does not work as well for you as the
previous one. Roxio’s Toast Titanium’s updater
can leave behind the old version, for example,
which takes up disk space – but it can be a
plus if the newer version doesn’t work. If it’s a
whole new version, say Quicken 2003 and 2002 ,
then I would still keep the old version around
until I was sure the new one was stable. Make
a TextEdit fi le to log the old versions and to
remind yourself to get rid of them when you’re
sure it’s OK . 0
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TIP!
Let the proxy icon
make things easier
for you:
Every so often you
may notice an icon to
the left of a window’s
name in the title bar.
Apple calls this a
proxy icon. Though
overlooked by most
people, it actually is
a quick way to work
with a folder. For
instance, to move
a folder to another
window, drive, or the
Trash, simply drag
the folder’s folder
icon to the desired
location. In addition,
you can use the proxy
icon to duplicate a
folder. To do so, hold
down the Option
key as you drag the
proxy icon to a new
location. You can
even save the copy in
the original folder if
you like.
You can also
create an alias of the
folder using the proxy
icon. Just hold down
Command-Option as
you drag the proxy
icon to the location
for the alias.
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Long Island Macintosh Users Group
Post Office Box 2048
Seaford, New York 11783-0180

Next month’s general meeting will feature
Audible Books,
Books a means of listening to
recorded books on an MP3 player.
“Audible digitally delivers a broad range
of audio programming over the Internet,
anywhere, anytime. At audible.com, you can
choose from over 4,500 audiobooks and
14,000 other audio programs, download them
to your computer, and listen immediately.”
Friday, June 13th at 7 p.m., Building 300, (Anna Rubin Hall),
New York Institute of Technology, Old Westbury.
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Helen and
Sheldon Gross
shel9
@ bellatlantic.net
Note: Sore Eyes site
referrals are for your
information only.
Neither the Grosses
nor LIMac endorse
any of the sites or
their products.

TIP!
Getting the most out
of annotations:
Acrobat’s annotations are a handy
way to keep track
of your thoughts as
you review a PDF
document. To get the
most from this feature, try these tips:
| In Acrobat 4,
choose Tools >
Annotations > Filter

Sore Eyes

User Group News

You never know all the angles. We’ve been
using Macs since they began (1984). We’ve
gone through all the options, and all the ideas
and are now using Mac OS 10.2.6 . I’m not
trying to brag; just to point out how some
things still escape us. I received an e-mail from
a friend who uses a Mac. He attached a threecolumn address list written in MS Word.
We have Word, so it shouldn’t have been
a problem. But when the list appeared, it was
in mime. Now, we have been translating all
kinds of items from one system to another.
We started by translating material from fiveinch floppies to three-inch disks, and even
from eight-inch disks to five-inch disks BM
(before Macintosh). We even went from Apple
to DOS and CPM . We were the experts. But
this one had us stumped. First, I tore my hair
out. Then I went to The Source: Bradley was
able to set me straight. All I had to do was
use StuffIt Expander, but I forgot to save the
attachment as plain text instead of Rich Text
Format (RTF). I love it when things work as
they should.
Which brings me to the main part of this
commentary. When we started with computers, back in the olden days, during the Civil
War, we joined APUG , the Apple Power Users
Group, which met at the New York Institute of
Technology. It was first a sub group (SIG), and
then a spin off from LICA , the Long Island
Computer Association. When we switched to
Macs, we found LIMac and have felt at home
here. My point is, that although the purpose
of User Groups has changed, we still find that
we cannot really manage without one. I guess
most of the members feel the same. It’s a place
to find friends and help. 0

Who says that evolution does not take Place?
Macworld Expo evolved into Create and now
Create has evolved into Macworld CreativePro
Conference & Expo. LIMac will be hosting a
User Group Booth and we are still looking for
a few volunteers to help us man it. If you can
give us a few hours any morning or afternnon
on one of the Expo days, please e-mail us at
aboutlimac @ aol.com.
The LIMac Executive Board is in the process of developing programs for our future
meetings. If there is a program, software, or
hardware topic that you would like to see presented please e-mail us at the same address.
The following vendors have special offers
for user group members only. Check their Web
sites:
| Watson – use to get information from the
Web. www.karelia.com/usergroup/.
| Avondale Media – instructional DVDs.
www.avondalemedia.com
| Mariner Software – word processing
and spreadsheets. For more info go to
www.marinersoftware.com To order, go to
www.marinersoftware.com/shopproduct.php.
1. At the bottom of the page look for Enter
other Promotional Codes Here.
2. Type in promotional code: MAR5103
3. Click GO and discounted prices will now be
reflected.
| Liquidlibrary – complete design projects quickly and efficiently. To order, go to
www.liquidlibrary.com; call 800-255-8800 ; or
e-mail sales @ liquidlibrary.com and use VIP
Code: 0119 0399 6301.
| O’Reilly – 20 percent discount on any
O’Reilly book purchased directly from
O’Reilly’s Website. www.oreilly.com/. 0
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Max Rechtman
maxlimac
@ optonline.net

Manager to choose
the type of annotations you want to
view. You can also
view annotations by
author.
| To see a list of
all the annotations
in a document
using Acrobat 4,
chose Window >
Show Annotations.
Click the button at
the bottom of the
Annotations pane to
scan the entire document for annotations,
then double-click
any annotation in
the list to go to that
page.
| If you want to
review just the
annotations in a document, open the document and choose
Tools > Annotations
> Summarize
Annotations. This
command creates a
separate document
listing the annotations on each page,
along with creation
times and authors.

